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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at http://documenta-
tion.softwareag.com. The site requires credentials for Software AG's Product Support site Empower.
If you do not have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.com with
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.
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About this Documentation

You can find product information on the Software AG Empower Product Support website at ht-
tps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.asp and give us
a call.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG TECHcommunity
website at http:/techcommunity.softwareag.com. You can:

" Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation” as an area of interest.
" Access articles, code samples, demos, and tutorials.

= Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

® Link to external websites that discuss open standards and web technology.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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2 Introduction to the Natural Wrapper

The Natural Wrapper is part of the EntireX Workbench in Software AG Designer. It supports users
to develop Natural client applications that access RPC-based server components and to create
Natural RPC server skeletons, which you can use as a basis for writing Natural RPC servers that
can be accessed by RPC clients.

The Natural Wrapper starts with a Software AG IDL file that describes the interfaces of the RPC
server or RPC client components. During wrapping the IDL program names are mapped to suitable
Natural names, which you can customize. This means that IDL program and IDL library names
can be longer than eight characters and can even contain characters not allowed in Natural names.

For Natural client applications it generates the following:

® Natural client interface objects (which are Natural subprograms; file extension .NSN) that can
be used in Natural client applications to access a remote RPC component. If there is a related
client-side mapping file (Natural | COBOL), this is also used (internally).

" Parameter data areas (PDA; one for each client interface object; file extension .NSA) defining
the interface to the Natural client interface objects. It is recommended to use the PDA in your
Natural client application.

" Sample Natural program (one for each interface object; file extension .NSP) that demonstrate
how to call the client interface object. See Sample Generation Result for the Client Side for more
information.

® In addition, a helper local data area (LDA), NATRPCL, can be generated to support correct
local compilation in a NaturalONE project in Software AG Designer. See Step 1: Specify the
RPC Environment.

For Natural server applications it generates the following:

® Natural RPC server skeletons (which are Natural subprograms; file extension .NSN).

® Parameter data areas (PDA; one for each server skeleton; file extension .NSA) defining the inter-
face to the RPC server.




Introduction to the Natural Wrapper

= If the server names (automatically generated or customized) differ from the IDL program names,
a client-side mapping file is required. See Server Mapping Files for Natural. It is generated during
generation of the RPC Server and has to be used in subsequent steps (wrapped into RPC client
components).

To generate these objects from the IDL file you need a Natural RPC environment, that is, a Natural
RPC server attached to an EntireX broker.

6 EntireX Natural Wrapper



3 Using the Natural Wrapper
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Using the Natural Wrapper

Starting the Natural Wrapper

Start the Natural Wrapper from the context menu of an IDL file: Natural > Generate RPC Client.

| p— — — I
atura - Na -NaturalClie atural-Librar .idl - Eclipse - D\devEchpse ompileTargetiwol ace &
2 NaturalONE - NatONE-NaturalClient/Natural-Libraries/NEWLIB/RES/MYLIB.idl - Eclipse SDK - D:\devEclipse\headCompileTargetiworksp oo B
File Edit MNavigate Search Project Run  Window Help
i &8 QS e o - %’ Service Devel.. [ EntireX %% Debug
5 or 42 : i
©= Navigator 52 0 & A8 BT S 0|k Musid 53 =
a b# MatOME-MaturalClient- >natu; New y |- Library 'MYLIB' is -
[ .settings o Program 'CRLC' is
4 (& Natural-Libraries * pen define data parameter
> B MYLIB Open With 4 1 gperator (A1) in
4 [ NEWLIE * - 1 operandl (I4) in
2 ERR GEl Copy i 1 operand2 (I4) in
4 G RES * Paste 1 result (i4) oumt
[ MYLB.idl ~| | 3 Delete end-define
& CMYUB'pmpert LnE 3 Program ‘'HELLO' is
- | Rename... define data parameter
el -natura N 1 name (&V) In
V) project ey Import.. 1 Hello (AV) out
> l=% Matural-Extractor &4y Export.. end-define
> & Natural-OBJ-RPC-> <unknow
P I P T TS &7 Refresh Program 'SQUARE' is
= Natural Server 2 — = define data parameter
=] EH localhost-2800 ) . 1 Value (I4) IN
CE User Libraries Show in Remote Systems view 1 Result (I4) ount
CE System Libraries Profile Az 3 end-define
Debug As 3
Run As 3
Replace With 3
B cosoL » -
ﬁ Integration Server > | . ’
ﬂ Matural 4 Generate RPC Client... ns E.Taskq =08
iﬁ Web Service 3 Generate RPC Server... E" 5@| = E~rh
Other y -
B Refactor Software AG IDL...
S Software AG IDL Tester...
Compare With 3
Team » &
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Using the Natural Wrapper

Using the Natural Wrapper for the Client Side

= Using the Natural Wrapper for the Client Side within NaturalONE
= Using the Natural Wrapper for the Client Side with a Remote RPC Environment
= Sample Generation Result for the Client Side

Using the Natural Wrapper for the Client Side within NaturalONE

= Step 1: Specify the RPC Environment
= Step 2: Customize Natural Client Names

Step 1: Specify the RPC Environment

The first wizard page prompts you to select an existing RPC environment or define a new one.
When running with NaturalONE, a default RPC environment is available. This is typically named
"localhost:1971@NATSRV2800" and refers to a running EntireX broker and Natural RPC server
on the local machine.

= Matural Wrapper l | E] | e
. i
Generate Natural Interface Objects
=

The Matural interface chjects will be generated from the selected Software AG IDL file,

This Wizard will help you to generate Natural interface objects from a Software AG IDL file,
Select or create a new RPC environment.

(71 Create a new RPC environment

(@ ilze existing RPC environment: |

! localhost1971 @RPC/MATSRV2800/ CALLNAT

[ Modify the selected RPC environment

@ < Back Net¢> |[ Fnsh || Cancel

EntireX Natural Wrapper 9



Using the Natural Wrapper

Check Use existing RPC environment, select the default RPC environment for NaturalONE and
press Next. Continue with Step 2: Customize Natural Client Names.

Changing the default RPC environment for NaturalONE is not required and not recommended,
so it is best to clear Modify the selected RPC environment. More information on changing an
RPC environment can be found in Step 2: Edit the RPC Environment (Optional) under Using the
Natural Wrapper for the Client Side with a Remote RPC Environment.

To use a different Natural RPC server for generation, create a new RPC environment. See Step 1:
Specify the RPC Environment under Using the Natural Wrapper for the Client Side with a Remote
RPC Environment.

Step 2: Customize Natural Client Names
On this page, adapt the names for the Natural client interface objects (subprograms (NSNs) with

their parameter data areas (PDAs)), names of the client test programs and specify the location to
which all Natural sources are to be written. The generation of client test programs can be disabled.

= Matural Wrapper

Customize Natural Client Names Used for IDL Library MYLIB

On this page you can adapt the names to be used for Matural Client Subprograms, Matural Client PDAs and Matural
Client Test Programs. You can disable the generation of Matural Client Test Programs.

Adapt names used for Matural Clients and select Matural Client Test programs you need:

IDL Program Client Subprogram  Client PDA Test Program
& aaic CALC CALCA CALCP

&P HELLO HELLO HELLOA HELLOP

<P SQUARE SQUARE SQUARER SQUAREP

Total: 3

Browse...

V| Generate Test Programs Customize the generation of Matural Test programs...

Location for the generated Matural Sources

Container:  /MNatOME-NaturalClient/Matural-Libraries/MEWLIB/RES

Finish l [ Cancel ]

@

b 4

2

Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

Check Generate Test Programs if client test programs for client interface objects are to be generated.
Clear this box if no test programs are to be generated. Use the link Customize the generation of
Natural Test programs to specify for each IDL program whether a test program is generated or
not. See Generate Test Programs for more information.

10 EntireX Natural Wrapper



Using the Natural Wrapper

For Natural ONE, the Location for the generated Natural sources should be in a Natural project.
If the target container is a source folder of a Natural project, the Natural builder will automatically

compile and build the source.
Press Next to start generation.

Generate Test Programs

On this page, specify for each IDL program whether a client test program is generated or not.

E ] e _— T
= Matural Client Names

==

Manage the generation of Natural Client Test Programs for IDL Library MYLIB

On this page you can manage the generation of Matural Client Test Programs by using the check-boxes.

Select the Matural Client Test prograrms to be generated

Test Program IDL Pregram
CALCP & calc
HELLOP &F HELLO
SQUAREP &F sQuARE

Selected: 3 of 3

@ ok ]

Cancel ]

L.

F - v

Check the IDL programs for which a client test program is to be generated. If a box is not checked,

no client test program is generated for that IDL program. Press OK to save the settings.

EntireX Natural Wrapper
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Using the Natural Wrapper

Using the Natural Wrapper for the Client Side with a Remote RPC Environment

= Step 1: Specify the RPC Environment

= Step 2: Edit the RPC Environment (Optional)

= Step 3: Select a Library (Optional)

= Step 4a: Customize Natural Client Names and Save Remotely (Optional)
= Step 4b: Customize Natural Client Names and Save Locally (Optional)

Step 1: Specify the RPC Environment

The first wizard page prompts you to use an existing RPC environment or create a new one.

P

= Matural Wrapper l | [=] ﬁ

. .
Generate Natural Interface Objects
The Matural interface chjects will be generated from the selected Software AG IDL file, m=p

This Wizard will help you to generate Matural interface objects from a Software AG IDL file,
Select or create a new RPC envircnment.

(71 Create a new RPC environment

@ Jze existing RPC environment: |

l ibmhost2:5403@RPC/NATSRVE2/CALLNAT

[l Medify the selected RPC envirenment

® < Back Mext = ] [ Finish ] ’ Cancel

~ To use an existing RPC environment

1

Check Use existing RPC environment, select the desired RPC environment and press Next.
If your previously defined filter (see Step 2: Edit the RPC Environment (Optional)) matches
more than one Natural library, continue with Step 3: Select a Library (Optional). If the filter

matches exactly one Natural library, continue with Step 4a: Customize Natural Client Names
and Save Remotely (Optional).

12
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Using the Natural Wrapper

2 Check Modify the selected RPC environment if you want to change settings prior to gener-
ation. Press Next and continue with Step 2: Edit the RPC Environment (Optional).

> To create a new RPC environment

m  Check Create a new RPC environment and press Next. Continue with Step 2: Edit the RPC
Environment (Optional).

Step 2: Edit the RPC Environment (Optional)

On this page, connection and authentication settings for the EntireX Broker and Natural RPC
server are managed, and you define if the Natural objects are saved remotely on the Natural RPC
server or locally within Software AG Designer.

EntireX Natural Wrapper 13



Using the Natural Wrapper

-

= Matural Wrapper

Edit RPC Environment

Define a new RPC Environment.

Broker Parameters
Broker ID: * ibmhost2:5403

Server Address: * RPC/NATSRVEZ/CALLMAT

Timeout (Seconds): 60

EntireX Authentication RPC Server Authentication
User Il RPC UserID:

Password: RPC Password:

Extractor Settings

Enter narnes, or use filter for range of values (wildcards * and ? on any position, < and > as final character only).

Library Name:

Program Mame:

Wrapper Settings
() Save locally

(@ Save remotely

Target Library Mame: © NAT*

Environment Name

() Default (ilbmhost2:5403@RPC/NATSRVEZ/CALLMNAT)

@ i0ther::  ibmhost2:5403@RPC/NATSRVEZ/CALLNAT

@ [ <Back || met> || Finih

Cancel

Define a new RPC environment or modify an existing one on this page. Required fields are Broker
ID, Server Address and the Environment Name. The timeout value must be in the range 1-9999
seconds (default: 60).

The EntireX Authentication fields apply to the broker.

The RPC Server Authentication fields apply to the RPC server. If the Natural RPC server is oper-
ating under Natural Security:

14 EntireX Natural Wrapper



Using the Natural Wrapper

® Your user ID and password must be defined in Natural Security. If the Natural Security user
ID or password differs from the broker user ID and password, use RPC Server Authentication
- otherwise use EntireX Authentication for both.

" Access to the Natural system library SYSIDL is required.
You can save the generated Natural sources locally or remotely:

* Locally
Sources are saved locally in the Software AG Designer. This setting is preferred if you develop
with Natural ONE and will additionally create a helper LDA, NATRPCL for correct local com-
pilation in a NaturalONE project in Software AG Designer. If you select this option, continue
with Step 4b: Customize Natural Client Names and Save Locally (Optional) and save locally.

* Remotely
Sources are saved remotely on the Natural RPC server. If you save the Natural sources remotely,
you have to specify a target Natural library. Enter either an exact name or use a filter for range
of values. The following wildcards are available:

"

* asterisk "*" (any position) to list names matching any sequence of characters

" question mark "?" (any position) to list names matching any single character
= greater than ">" (final character only) to list names after

* lower than "<" (final character only) to list names before

Only Natural libraries that reside in the FUSER system file of the Natural RPC server can be
specified. The Natural library specified is not created from the EntireX workbench, it must exist
in the FUSER system file (at least one Natural object stored here).

Press Next. If your filter matches more than one Natural library, continue with Step 3: Select a
Library (Optional). If the filter matches exactly one Natural library, continue with Step 4a:
Customize Natural Client Names and Save Remotely (Optional) and save remotely.

Step 3: Select a Library (Optional)

All Natural libraries that reside in the FUSER system file of the Natural RPC server and that match
the filter defined in Step 2: Edit the RPC Environment (Optional) are listed here. This step is
skipped if exactly one Natural library matches the filter specification defined in Step 2: Edit the
RPC Environment (Optional). In this case, continue with Step 4a: Customize Natural Client Names
and Save Remotely (Optional).

EntireX Natural Wrapper 15



Using the Natural Wrapper

[ . —— -_— N
= Matural Wrapper — - ———— -
I _am
Select a Library =
The Matural objects will be deployed into the selected library,

List of Matural libraries:

Mame

MAT-1929
MNATCLASS
MNATCLIPS
MNATMFLE
MATMFS
MNATQA
MNATZIP
MATIT071
MAT314

Total: 9

[] Qverwrite existing Natural objects

e ¥

Select the Natural library where you want to save the generated Natural sources and press Next.
Continue with Step 4a: Customize Natural Client Names and Save Remotely (Optional).

Press Finish to skip all preceding steps and start generation immediately. If the generated Natural
objects already exist from a previous generation, check Overwrite existing Natural objects.

Step 4a: Customize Natural Client Names and Save Remotely (Optional)
On this page, adapt the names for the Natural client interface objects (subprograms (NSNs) with

their parameter data areas (PDAs)), and the names of the client test programs. The generation of
client test programs can be disabled.

16 EntireX Natural Wrapper



Using the Natural Wrapper

= Matural Wrapper SRR X
Customize Matural Client Names Used for IDL Library MYLIB
On this page you can adapt the names to be used for Matural Client Subprograms, Matural Client PDAs and Matural S

Client Test Programs. You can disable the generation of Matural Client Test Programs.

Adapt names used for Matural Clients and select Natural Client Test programs you need:

IDL Program Client Subprogram  Client PDA Test Program
&Fealc CALC CALCA CALCP

4P HELLO HELLO HELLOA HELLOP

P SQUARE SQUARE SQUAREA SQUAREP

[¥| Generate Test Programs Total: 3
[] Overwrite existing Matural objects
@:l PMlext » [ Finish l [ Cancel l

] Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

Check Generate Test Programs if client test programs for client interface objects are to be generated.
Clear this box if no test programs are to be generated. Use the link Customize the generation of
Natural Test programs to specify for each IDL program whether a test program is generated or
not. See Generate Test Programs for more information.

If the generated Natural objects already exist from a previous generation, check Overwrite existing
Natural objects.

Press Next to start generation.
Step 4b: Customize Natural Client Names and Save Locally (Optional)

On this page, adapt the names for the Natural client interface objects (subprograms (NSNs) with
their parameter data areas (PDAs)), names of the client test programs, and specify the location to
which all Natural sources are to be written. The generation of client test programs can be disabled.

EntireX Natural Wrapper 17
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' 5
= Matural Wrapper - l (=] i&]

4

Customize Matural Client Names Used for IDL Library MYLIB =
On this page you can adapt the names to be used for Matural Client Subprograms, Matural Client PDAs and Matural
Client Test Programs. You can disable the generation of Matural Client Test Programs.

Adapt names used for Matural Clients and select Natural Client Test programs you need:

IDL Program Client Subprogram  Client PDA Test Program

&Fealc CALCOON CALCO0A CALCOOP

4P HELLO HELLOON HELLOOA HELLOGOP

P SQUARE SQUAREN SQUAREA SQUAREP

[¥] Generate Test Programs Customize the generation of Natural Test programs... Total: 3
Location for the generated MNatural Sources

Container: /Matural-Wrappet Browse...
® ot ) (] (e

J Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

Check Generate Test Programs if client test programs for client interface objects are to be generated.
Clear this box if no test programs are to be generated. Use the link Customize the generation of
Natural Test programs to specify for each IDL program whether a test program is generated or
not. See Generate Test Programs for more information.

Specify the Location for the generated Natural sources. Select a container (folder or project) in
Software AG Designer.

Press Next to start generation. Continue with Sample Generation Result for the Client Side.
Generate Test Programs

On this page, specify for each IDL program whether a client test program is generated or not.

18 EntireX Natural Wrapper



Using the Natural Wrapper

——————— ——
= Matural Client Names

==

Manage the generation of Natural Client Test Programs for IDL Library MYLIB =
On this page you can manage the generation of Matural Client Test Programs by using the check-boxes.

Select the Matural Client Test programs to be generated

Test Program IDL Pregram

CALCP & caLc

HELLOP &F HELLO

SQUAREP 47 SQUARE

Selected: 3 of 3

@::l [ oK ] [ Cancel

Check the IDL programs for which a client test program is to be generated. If a box is not checked,
no client test program is generated for that IDL program. Press OK to save the settings.

Sample Generation Result for the Client Side

The following screen shows the successful generation of Natural client interface objects (subpro-
grams (NSNn) with their parameter data areas (PDAs (extension NSA)), client test program (NSPs)
and the common data area NATRPCL.NSL). The Wrapper Settings included Save locally in a

NaturalONE environment.

EntireX Natural Wrapper
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. 5
= NaturalOME - NatOME-NaturalClient/Natural-Libraries/MEWLIB/SRC/CALCP.NSP - Eclipse SDK —— A— — l = é
File Edit Mavigate Search Project Run  Window Help

CH = = E- R IR 4 F v vx0 oov - ﬁ’a Service Devel.. [ EntireX %% Debug >
5. Navigator 52 =0 CALCP.NSP &3 =0
¢ B AR 7| ¢ /7 m
E_jJ Mixed-Passwaords o /* Set RPC context and logon t_:,: k:.':cke: )
(2 NatONE-NaturalClient-> < unknown () * SSIGN RI?E—ENE%{;F-EJNCTION = 'SL' /* Set RPC context and logon to broker
(o settings ¢ \T 'REC-CNTX' RPC-CNTX
o ADD 1 TO IDX
& Natural-Libraries * COMPRESS REC—CNTX.ERR-TEXT INTO PROGRESS-MSG (IDX)
& MVLIE = IF RPC-CNIX.ERR-CCDE NE 0
(& NEWLIB * — error setting RPC context or logon to broker
8 ERR PUT FULL REINPUT-MSG
& RES * END-IF
[ MYLIBdI ALS5IGN LOGGED-ON = TRUE
MYLIB.properties ™ L s *
@ SRC ~ 1
CALC.NSN “%
BE CALCANSA ~% LC: error occured.' INTO PROGRESS-MSG (IDX)
CALCP.NSP ~% B +LLanb
HELLO.NSN *% CPERATOR
HELLOA.NSA *% OPERRND1 1
HELLOP.NSP 7% OPERRND2 3
3£ NATRPCLNSL % . BESULT )
SQUARENSN ~2% . -T:HP_&;.::; Calling CARLC: success INTC PROGRESS-MSG (IDX)
P SQUAREANSA "% = ® goff from broker
=H Matural Server 23 o= ®|2% =08 55IGN RPC-CNTX.FUNCTION = 'LE' /* Logoff from broker
AT 'RPC-CNTX' RPC-CNTX
ADD 1 TO IDX
COMPRESS RPC-CNTX.ERR-TEXT INTO PROGRESS-MSG (IDX)
= IF RPC-CNTX.ERR-CODE NE 0
/* error logoff from broker S
4 F
nf Writable Smart Insert 17:23
=

Using the Generated Sample Natural Program

Before you use the generated sample Natural program (extension .NSP), make sure the Natural
library SYSEXT is defined as a steplib for the Natural environment. Use one of the following
methods, depending on your environment:

® for NaturalONE, use the context menu of the Natural ONE project and choose Properties >
Natural > Environment, add SYSEXT

® for Natural Security environments, use SYSSEC

® for any other Natural environment, use NATPARM
The generated sample Natural program (extension .NSP) demonstrates standard RPC usage.

See also the readme files of the Client and Server Examples for Natural for more information on
working with Natural RPC clients.
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Using the Natural Wrapper for the Server Side

= Using the Natural Wrapper for the Server Side within NaturalONE
= Using the Natural Wrapper for the Server Side with a Remote RPC Environment
= Sample Generation Result for the Server Side

Using the Natural Wrapper for the Server Side within NaturalONE

= Step 1: Specify the RPC Environment
= Step 2: Customize Natural Server Names

Step 1: Specify the RPC Environment
The first wizard page prompts you to select an existing RPC environment or define a new one.
When running with NaturalONE, a default RPC environment is available. This is typically named

"localhost:1971@NATSRV2800" and refers to a running EntireX broker and Natural RPC server
on the local machine.

= Matural Wrapper l [=] é,l

Generate Natural Server
The Matural server will be generated from the selected Software AG IDL file, nd

This Wizard will help you to generate Matural server from a Software AG IDL file, Select or
create a new RPC environment.

(71 Create a new RPC environment

(@ ilze existing RPC environment: |

! localhost1971 @RPC/MATSRV2800/ CALLNAT

[ Modify the selected RPC environment

@ < Back Ne¢> |[ Finish || Cancel
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Check Use existing RPC environment, select the default RPC environment for NaturalONE and
press Next. Continue with Step 2: Customize Natural Server Names.

Changing the default RPC environment for NaturalONE is not required and not recommended,
so it is best to clear Modify the selected RPC environment. More information on changing an
RPC environment can be found in Step 2: Edit the RPC Environment (Optional) under Using the
Natural Wrapper for the Server Side with a Remote RPC Environment.

To use a different Natural RPC server for generation, create a new RPC environment. See Step 1:
Specify the RPC Environment under Using the Natural Wrapper for the Server Side with a Remote
RPC Environment.

Step 2: Customize Natural Server Names

On this page, adapt the names for the Natural RPC server skeletons (subprograms (NSNs) with
their parameter data areas (PDAs)) and specify the location to which all Natural objects are to be
written.

= Matural Wrapper I. =l &J

. . i
Customize Natural Server Names Used for IDL Library EXAMPLE &=

On this page you can adapt the names to be used for Matural Server Subprograms and Matural Server PDAs, =p
Adapt names used for Matural Server:

IDL Program Server Subprogram  Server PDA

4P sQuARE SSQUARE] ASQUARE

&P calc SCALC ACALC

4P HELLO SHELLO AHELLO

Total: 3

Location for the generated Matural Sources

Container:  NatONE-NaturalServer/Natural-Libraries/NEWLIE/RES
@ Ned> [ Finish  |[  Cancel |

] Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

For NaturalONE, the location for the generated Natural sources should be in a Natural project. If
the target container is a source folder of a Natural project, the Natural builder will automatically
compile and build the source.

Press Next to start generation. Continue with Sample Generation Result for the Server Side.
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Using the Natural Wrapper for the Server Side with a Remote RPC Environment

= Step 1: Specify the RPC Environment

= Step 2: Edit the RPC Environment (Optional)

= Step 3: Select a Library (Optional)

= Step 4a: Customize Natural Server Names and Save Remotely (Optional)
= Step 4b: Customize Natural Server Names and Save Locally (Optional)

Step 1: Specify the RPC Environment

The first wizard page prompts you to use an existing RPC environment or create a new one.

-

= Matural Wrapper

Generate Natural Server

The Matural server will be generated from the selected Software AG IDL file.

This Wizard will help you to generate Matural server from a Software AG IDL file. Select or
create a new RPC environment.

(71 Create a new RPC environment

@ Jze existing RPC environment: |

l ibmhost2:5403@RPC/NATSRVE2/CALLNAT

[l Medify the selected RPC envirenment

® « Back Mext » Einish

~ To use an existing RPC environment

1 Check Use existing RPC environment, select the desired RPC environment and press Next.
If your previously defined filter (see Step 2: Edit the RPC Environment (Optional)) matches
more than one Natural library, continue with Step 3: Select a Library (Optional). If the filter

matches exactly one Natural library, continue with Step 4a: Customize Natural Server Names
and Save Remotely (Optional).
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2 Check Modify the selected RPC environment if you want to change settings prior to gener-
ation. Press Next and continue with Step 2: Edit the RPC Environment (Optional).

> To create a new RPC environment

m  Check Create a new RPC environment and press Next. Continue with Step 2: Edit the RPC
Environment (Optional).

Step 2: Edit the RPC Environment (Optional)

On this page, connection and authentication settings for the EntireX Broker and Natural RPC
server are managed, and you define whether the Natural sources are saved remotely on the Nat-
ural RPC server or locally within Software AG Designer.
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-

= Matural Wrapper

-

||

Edit RPC Environment

Define a new RPC Environment.

Broker Parameters

Broker ID: * ibmhost2:5403
Server Address: RPC/NATSRVBZ/CALLMAT

Timeout (Seconds): 60

EntireX Authentication
User Il

Password:

Extractor Settings

Enter narnes, or use filter for range of values (wildcards * and ? on any position, < and > as final character only).

Library Name:

Program Mame:

Wrapper Settings
() Save locally

(@ Save remotely

Target Library Mame: © NAT*

Environment Name

() Default (ilbmhost2:5403@RPC/NATSRVEZ/CALLMNAT)

@ i0ther::  ibmhost2:5403@RPC/NATSRVEZ/CALLNAT

-

RPC Server Authentication
RPC UserID:

RPC Password:

@ [

<Back | Net> | iivish

Define a new RPC environment or modify an existing one on this page. Required fields are Broker
ID, Server Address and the Environment Name. The timeout value must be in the range 1-9999
seconds (default: 60).

The EntireX Authentication fields apply to the broker.

The RPC Server Authentication fields apply to the RPC server. If the Natural RPC server is oper-
ating under Natural Security:

EntireX Natural Wrapper
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® Your user ID and password must be defined in Natural Security. If the Natural Security user
ID or password differs from the broker user ID and password, use RPC Server Authentication
- otherwise use EntireX Authentication for both.

" Access to the Natural system library SYSIDL is required.
You can save the generated Natural sources locally or remotely:

* Locally
Sources are saved locally in the Software AG Designer. This setting is preferred if you develop
with NaturalONE. If you select this option, continue with Step 4b: Customize Natural Server
Names and Save Locally (Optional) and save locally.

" Remotely
Sources are saved remotely on the Natural RPC server. If you save the Natural sources remotely,
you have to specify a target Natural library. Enter either an exact name or use a filter for range
of values. The following wildcards are available:

" asterisk "*" (any position) to list names matching any sequence of characters

" question mark "?" (any position) to list names matching any single character

= greater than ">" (final character only) to list names after

® lower than "<" (final character only) to list names before

Only Natural libraries that reside in the FUSER system file of the Natural RPC server can be

specified. The Natural library specified is not created from the EntireX workbench, it must exist
in the FUSER system file (at least one Natural object stored here).

Press Next. If your filter matches more than one Natural library, continue with Step 3: Select a
Library (Optional). If the filter matches exactly one Natural library, continue with Step 4a:
Customize Natural Server Names and Save Remotely (Optional) and save remotely.

Step 3: Select a Library (Optional)

All Natural libraries that reside in the FUSER system file of the Natural RPC server and that match
the filter defined in Step 2: Edit the RPC Environment (Optional) are listed here. This step is
skipped if exactly one Natural library matches the filter specification defined in Step 2: Edit the
RPC Environment (Optional) In this case, continue with Step 4a: Customize Natural Server Names
and Save Remotely (Optional).
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-

= Matural Wrapper

Select a Library

The Matural objects will be deployed into the selected library,

List of Matural libraries:

Mame

MAT-1929
MNATCLASS
MNATCLIPS
MNATMFLE
MATMFS
MNATQA
MNATZIP
MATIT071
MAT314 I

Total: 9

[] Qverwrite existing Natural objects

e ¥

Select the Natural library where you want to save the generated Natural sources and press Next.
Continue with Step 4a: Customize Natural Server Names and Save Remotely (Optional).

The Finish is enabled if no related XMM file exists. If you press Finish and the generated Natural
objects already exist from a previous generation, check Overwrite existing Natural objects.

Step 4a: Customize Natural Server Names and Save Remotely (Optional)

On this page, adapt the names for the Natural RPC server skeletons (subprograms (NSNs) with
their parameter data areas (PDAs)).
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-

Customize Matural Server Names Used for IDL Library EXAMPLE

= Matural Wrapper I. (=] ﬁ]
i
4=

On this page you can adapt the names to be used for Matural Server Subprograms and Matural Server PDAs,

Adapt names used for Matural Server:

IDL Program Server Subprogram  Server PDA
P SQUARE 5SQUARE] ASQUARE
&Pealc SCALC ACALC
4P HELLO SHELLO AHELLO

Total: 3

[7] Overwrite existing Matural objects

@ Net> | [ Finish | [ cancel |

] Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

If the generated Natural objects already exist from a previous generation, check Overwrite existing
Natural objects.

Press Next to start generation.
Step 4b: Customize Natural Server Names and Save Locally (Optional)

On this page, adapt the names for the Natural RPC server skeletons (subprograms (NSNs) with
their parameter data areas (PDAs)) and specify the location to which all Natural sources are to be
written.
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-

Customize Matural Server Names Used for IDL Library EXAMPLE

= Matural Wrapper I. (=] ﬁ]
i

On this page you can adapt the names to be used for Matural Server Subprograms and Matural Server PDAs,

Adapt names used for Matural Server:

IDL Program Server Subprogram  Server PDA
F SQUARE SSQUARE ASQUARE
&Pealc SCALC ACALC
&P HELLO SHELLO AHELLO

Total: 3

Location for the generated Matural Sources

Container: MaturalWrapper

I @j PMlext » [ Finish l [ Cancel I

b

4

d Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

Specify the Location for the generated Natural sources. Select a container (folder or project) in
Software AG Designer.

Press Next to start generation. Continue with Sample Generation Result for the Server Side.

Sample Generation Result for the Server Side

The following screen shows the successful generation of the Natural RPC server skeletons (sub-
programs (NSNs) with their parameter data areas (PDAs (extension NSA))). The Wrapper Settings
included Save locally in a NaturalONE environment.
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-
2 NaturalONE - NatONE-NaturalServer/Natural-Libraries/NEWLIB/SRC/ACALCNSA - Edipse SDK i i i [E=REER

File Edit Mavigate Search Project Run  Window Help
Ci-EE& a8 @ o4 HER AT IR SRR IS 4 ﬁ Service Devel.. [.| EntireX %% Debug >
U5 Mavigator &3 =0 =0

=R

Q MatOME-MaturalServer-»> cunknown= (1) *
= settings
&= Matural-Libraries *
& NEWLIE *
& ERR
& RES
(S SRC *
B ACALCNSA ~%
B AHELLO.NSA %
Bf ASQUARENSA ~%
SCALC.MSN %
SHELLO.NSMN ~%
SSQUARE.NSM *%

-

SCALC.NSN 1
ZDEFINE DATZ PARAMETER -

® /+ >Natural Source Headsr 000000[]
S R R R R R R R R R R R R R KRR R R R R R R R R R R R R R R R R KRR R R R R R R

=

Pk PDA ACRLC for Interface SCALC.

Sk Path: example.idl

Sk IDL Library: EXAMPLE

/%=  IDL Program: CALC

S

Pk Generated by Software AG,

Joek Watural Wrapper 8.3.0.0

Sk WNatural 08.02.03.0001, SYSIDL &.3.13.0
/%=  on 2012-12-13 13:06:39

S

R R R R R R R R R R R R R R R PR R R R R R R R PR R R R

/* Direction according to IDL

.natural
{2 project 1 OPERATICN (I1) /* inout /%** :inout
=% Natural-Extractor i 1 CPERRND1 (I4) /* inout /** :inout
—u 1 OPERLRNDZ (I4) /* imout /** :inout
=H Natural Server i3 | =H x | =0 1 FUNCTION-RESULT (I4) /% inout /** :inout
END-DEFINE
1 b
o* | Writable | Smart Insert | 1:1
~ _ 4

See also the readme files of the Client and Server Examples for Natural for more information on
working with Natural RPC servers.
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4 RPC Environment Manager for Natural RPC Server

The RPC environment for a Natural RPC Server is managed on the Preferences page.
Use the RPC Environment Monitor to check the availability of each RPC environment.

Using this wizard, you can add new RPC environments for a Natural RPC Server. To manage
these RPC environments, open the Preferences page.

< Preferences - I lilﬂlg
type filter text RPC Environments for Natural RPC Server fror
“ SU&V\TNE AG Manage the RPC Environments for Natural RPC Server.
» Ajax Developer
APL-Portal Table of defined RPC environments:
» Business Services Name = Broker ID Server Address Insert...
» Code Generation
Natura\ RPC Server localhost:1971 RPC/MATSRV_UNKNOWN/CALLNAT y
» Construct Edit...
Document Expansion i -
4 EntireX Duplicate
» COBOL E Remove
Integration Servers
a Matural
IDL Extractor for Matural N
Matural Wrapper
RPC Environments for Matural RPC Server
> PLA
> Web Services
> Wrappers -
@ @ [ QK ] [ Cancel ]

] Note: If NaturalONE is installed, a predefined RPC environment is provided for the default

Natural server. This RPC environment cannot be removed. The server address of the Nat-
ural server is managed by NaturalONE, but other settings can be changed.

~ To edit an existing RPC environment

= Select the table row and press Edit.... If multiple entries are selected, the first entry is used.
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> To remove an RPC environment

Slect the table row and press Remove. You can select multiple environments.

> To create a new RPC environment

1

Choose Insert... to call the following screen:

-

& RPC Envircnments

New RPC Envirenment for Natural RPC Server

Define a new RPC Environment.

Broker Parameters

Broker ILx ol calhost1971
Server Address: * RPC/SRVL/CALLMAT

Timeout (Seconds): 60

EntireX Authentication
User ID:

Password:

Extractor Settings

Enter names, or use filter for range of values (wildcards * and 7 on any position, < and = as final character only).

Library Mame:

Program Mame:

Wrapper Settings
@ Save locally

() Save remotely

Environment Mame
(71 Default

@ Other:  Matural RPC Server (2)

< Back

RPC Server Authentication
RPC User ID:

RPC Password:

Next > [

Finish

|| Cancel
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2 Enter the required fields: Broker ID, Server Address and a unique Environment Name, which
will have the default format brokerID@serverAddress. The given Timeout value must be in the
range from 1 to 9999 seconds (default: 60).

EntireX Authentication describes the settings for the broker, and RPC Server Authentication
describes the settings for the RPC server.

The Wrapper Settings are used for Natural Wrapper, and you can specify the operation type
and target library name (not available for Save locally).

EntireX Natural Wrapper 33



34



5 RPC Environment Monitor

The RPC Environment Monitor is part of the EntireX Workbench. It is an Eclipse view that provides
a quick overview of the availability of the defined RPC environments in your workspace.

~ To open the RPC Environment Monitor from the EntireX perspective

s Choose Window > Show View > RPC Environment Monitor.

~ To open the RPC Environment Monitor from a non-EntireX perspective

s Choose Window > Show View > Other > Software AG > RPC Environment Monitor.

The RPC environments are managed on the Preferences page. See RPC Environment Manager
for Natural RPC Server.

RPiC Enwiranment Monitar &2 2]

Table of defined RPC environments:

MName Broker ID Server Address Skatus
7 Java RPC Server @ localhost: 1971 @ RPC/SRY1JCALLMNAT Broker Error 0007 0007; RPC/SRYLMCALLMAT not registered
-_'3” Matural RPC Server @ localhost: 1971 B RPC/MATSRWZEO0MCALLMAT - Matural RPC Server 6.3.4.4 on WHNT-2386 (NATAS11.0)
E’ﬂ #MLISCAP RPC Server B localhost: 1971 @ RPOSRMUSERVER/CALLMAT  Enkired #ML RPC Server 8.2.2.0,162 Windows 2P 5.1 %86,

The status check starts when the view is opened. To force an additional check, choose Refresh
from the Views toolbar. The status check can be cancelled in the dialog that appears or within the
Eclipse progress view. When the check is complete or if it cancelled, the following symbols indicate
the status of the corresponding item. The table will be reloaded every time a status check is started
to make sure all stored RPC environments are available.
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Symbol | Status

| Running.
e Not running.
E4AN

Unknown (at the beginning of the check or if the check was cancelled).

| Note: Additional status information (including error messages) is displayed when refreshing
the view (by a ping command to all specified RPC servers).
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6 Using the Natural Wrapper in Command-line Mode

B ComMMANGA-INE OPLONS ....iiiiiii ittt e et e e e ettt e e e e e e e e e e e e e e
= Example: Generating an RPC ClIENt .........oooiiiiiiiiiii et
= Example: Generating @n RPC SEIVEE ........oiiiiiiiiieiit e
I V(g TC g e Ty o)L= PP PP OPPOPPPPPPRS
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Command-line Options

This section provides the command-line options for the following tasks:

= Generating a Natural RPC Client from an IDL File
= (Generating a Natural RPC Server from an IDL File

See Using the EntireX Workbench in Command-line Mode for the general command-line syntax.

Generating a Natural RPC Client from an IDL File

To generate a Natural RPC client from the specified IDL file, use the following command with
options in table below:

-natural:client

Option Description
-brokerpassword|Password used for broker authentication.
-brokeruser User used for broker authentication.

-environment

Name of the environment or an RPC server description.

-help

Display this usage message.

-operationtype

The operation type. Valid values are:

SAVE Generate Natural interface objects remotely on the server side

GET Generate Natural interface objects locally using Software AG Designer

-overwrite

Overwrite existing Natural interface objects on the server side (SAVE command only).

-targetlibrary

The target library for the Natural interface objects on the server side (SAVE command
only).

-rpcpassword

Password used for RPC server authentication.

-rpcuser

User used for RPC server authentication.

Generating a Natural RPC Server from an IDL File

To generate a Natural RPC server from the specified IDL file, use the following command with
options in table below:

38
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-natural:server

Option Description

-brokerpassword|Password used for broker authentication.

-brokeruser User used for broker authentication.

-environment Name of the environment or an RPC server description.
-help Display this usage message.

-operationtype |The operation type. Valid values are:

SAVE Generate Natural interface objects remotely on the server side.

GET Generate Natural interface objects locally using Software AG Designer.

-overwrite Overwrite existing Natural interface objects on the server side (SAVE command only).

-targetlibrary |The target library for the Natural interface objects on the server side (SAVE command
only).

-rpcpassword Password used for RPC server authentication.

-rpcuser User used for RPC server authentication.

Example: Generating an RPC Client

<workbench> -natural:client /Demo/Example.idl -environment Tocalhost:1971@SRV1 <
-operationtype SAVE -targetlibrary MYLIB

where <workbench> is a placeholder for the actual Workbench starter as described under Using
the EntireX Workbench in Command-line Mode.

The name of the IDL file includes the project name. In the example, the project Demo is used. If
the IDL file name describes a file inside the Eclipse workspace, the name is case-sensitive.

If the first part of the IDL file name is not a project name in the current workspace, the IDL file
name is used as a relative (based on the IDL file) or absolute file name in the file system. Thus, the
IDL files do not need to be part of an Eclipse project.
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Example: Generating an RPC Server

<workbench> -natural:server /Demo/Example.idl -environment Tocalhost:1971@SRV1 <
-operationtype SAVE -targetlibrary MYLIB

where <workbench> is a placeholder for the actual Workbench starter as described under Using
the EntireX Workbench in Command-line Mode.

(p  Caution: Take care not to overwrite an existing server implementation with a server skeleton.

We recommend you move your server implementation to a different folder.

Further Examples

Example 1

<workbench> -natural:client /Demo/example.idl -environment localhost:1971@SRV1 <
-operationtype GET

Uses the IDL file /Demo/example.idl and generates the Natural source files in parallel to the IDL file
of the project /Demo. Output to standard output:

Using workspace file:/C:/myWorkspace/.

Processing IDL file C:/myWorkspace/Demo/example.idl to get the Natural interface <
objects via RPC environment Tocalhost:1971@SRV1

Store Natural Source file C:\myWorkspace\Demo/CALC.NSN

Exit value: 0O

Example 2

<workbench> -natural:client /Demo/example.idl -environment localhost:1971@SRV1 <
-operationtype SAVE -targetlibrary TEST

Uses the IDL file /Demo/example.idl and generates the Natural source files on the server side into
the library TEST. Output to standard output:
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Using workspace file:/C:/myWorkspace/.

Processing IDL file C:/myWorkspace/Demo/example.idl to stow the Natural interface <
objects via RPC environment localhost:1971@SRV1
Exit value: 0
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7 Software AG IDL to Natural Mapping

Mapping IDL Data Types to Natural Data FOrMats ............oooiviiiiiiiiiii e
Mapping Library Name and Alias ..............
Mapping Program Name and Alias ............
Mapping Parameter Names .....................
Mapping Fixed and Unbounded Arrays ......
Mapping Groups and Periodic Groups .......
Mapping Structures ...........ccccoeevvvvvveeennn.

= Mapping the Direction Attributes In, OuUt, INOUL ..........oiiiiii e

= Mapping the ALIGNED Attribute ...............

= Calling Servers as Procedures or Functions
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This chapter describes the specific mapping of Software AG IDL data types, groups, arrays and
structures to the Natural programming language. Please note also the remarks and hints on the
IDL data types valid for all language bindings found in the IDL file. See Software AG IDL File in
the IDL Editor documentation.

Mapping IDL Data Types to Natural Data Formats

In the table below, the following metasymbols and informal terms are used for the IDL.

® The metasymbols "[" and "]" enclose optional lexical entities.

® The informal term number (or in some cases numberl.number?)is a sequence of numeric characters,

for example 123.

Software AG IDL Description Natural Data Format Notes
Anumber Alphanumeric Anumber
AV Alphanumeric variable length A DYNAMIC
AVnumber Alphanumeric variable length with maximum  |A DYNAMIC
length

Bnumber Binary Bnumber
BV Binary variable length B DYNAMIC
BVnumber Binary variable length with maximum length B DYNAMIC
D Date D 3,5
F4 Floating point (small) F4 2
F8 Floating point (large) F8 2
I1 Integer (small) I1
12 Integer (medium) 1?2
14 Integer (large) I4
Knumber Kanji Anumber 1
KV Kanji variable length A DYNAMIC 1
KVnumber Kanji variable length with maximum length A DYNAMIC 1
L Logical L
Nnumberll .number2] |Unpacked decimal Nnumberll.number2]|6
NUnumberlIl.numberZ]|Unpacked decimal unsigned Nnumberll.number2]|6
Pnumberll.number2] |Packed decimal Pnumberll.number2]|6
PUnumberll.numberZ2]|Packed decimal unsigned PnumberlIl.numberZ2]|6
T Time T 4,5
Unumber Unicode Unumber
uv Unicode variable length U DYNAMIC
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Software AG IDL

Description

Natural Data Format

Notes

UVnumber

Unicode variable length with maximum length

U DYNAMIC

See also the hints and restrictions valid for all language bindings under IDL Data Types.

Notes

1. Data type Kis an RPC-specific data format that is not part of the Natural language.

2. When floating-point data types are used, rounding errors can occur, so that the values of senders and

receivers might differ slightly. This is especially true if client and server use different representations
for floating point data (IEEE, HFP).

. Count of days AD (anno domini, after the birth of Christ). The valid range is from 1.1.0001 up to
28.11.2737. Mapping of the number to the date in the complete range from 1.1.0001 on, follows the Julian
and Gregorian calendar, taking into consideration the following rules:

1. Years that are evenly divisible by 4 are leap years.
2. Years that are evenly divisible by 100 are not leap years unless rule 3, below, is true.
3. Years that are evenly divisible by 400 are leap years.

4. Before the year 1582 AD, rule 1 from the Julian calendar is used. After the year 1582 AD, rules 1, 2
and 3 of the Gregorian calendar are used.

See the following table for the relation of the packed number to a real date:

Date / Range of Dates Value / Range of Values

1.1.0000 0 (special value - no date)
undefined dates 1 - 364 (do not use)

1.1.0001 365

1.1.1970 719527 (start of C-time functions)
28.11.2737 999999 (maximum date)

. Count of tenths of seconds AD (anno domini, after the birth of Christ). The valid range is from 1.1.0001
00:00:00.0 up to 16.11.3168 9:46:39 plus 0.9 seconds. See the following table for the relation of the packed
number to a real time:

Time / Range of Times Value / Range of Values

1.1.0000 00:00:00.0 0 (special value - no time)

undefined times 1 - 315359999

1.1.0001 00:00:00.0 315360000

1.1.1970 00:00:00.0 621671328000 (start of C-time functions)

5. The relation between the packed number of a Date and Time data type is as follows:

tenths of a second per day =24*60*60*10 = 864000

number of time = number of date * 864000
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315360000 =365 * 864000 1.1.0001 00:00:00.0
621671328000 = 719527 * 864000 1.1.1970 00:00:00.0
number of date = number of time / 864000

365 = 315360000 / 864000 1.1.0001

719527 = 621671328000 /864000 1.1.1970

6. For Natural, the total number of digits (numberI+number?) is restricted to 29.

If you connect two endpoints, the total number of digits used must be lower or equal than the maxima
of both endpoints. For the supported total number of digits for endpoints, see the notes under data
types N, NU, P and PU in section Mapping Software AG IDL Data Types in the respective Wrapper or
language-specific documentation.

Mapping Library Name and Alias

Client Side

If you are using client interface objects (recommended) generated for the client side (see Using the
Natural Wrapper for the Client Side), the IDL library name as specified in the IDL file (there is no
8 character limitation) is sent from a Natural client to the server. Special characters are not replaced.
The IDL library alias is neither sent to the server nor used for other purposes on the Natural client
side.

If you are using instead so-called stubs generated with SYSRPC (not recommended) or stubless
Natural RPC (also not recommended), the IDL library name as specified in the IDL file is not
supported by Natural. By default, a Natural client sends the library name SYSTEM to the server.
To send a library name other than SYSTEM from a Natural client to a server, the following steps
are required for the client:

® Turn on the logon option.

® Call application programming interface USR4008N to specify the name of the library, otherwise
the name of the current library is sent. The length of the library name sent is limited to 8 charac-
ters.
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Server Side

A Natural RPC Server considers the library name (up to 8 characters) received from an RPC client
only if the Natural Logon option is set by the sending RPC client.

= If the RPC client does not set its Natural Logon option, the Library name is ignored by the Nat-
ural RPC server and the target RPC server (Natural subprogram, extension .NSN) is searched
in the startup Natural library and defined steplibs of the Natural RPC server.

= If the RPC client does set its Natural Logon option, the target RPC server (Natural subprogram,
extension .NSN) must reside in the Natural library, specified as IDL library name in the IDL
file.

EntireX RPC client components provide a possibility to set the Natural Logon option. See Natural
Logon or Changing the Library Name and the documentation of the EntireX RPC client component.

Mapping Program Name and Alias

Client Side

If you are using client interface objects (recommended) generated with the Natural Wrapper for
the client side (see Using the Natural Wrapper for the Client Side), the IDL program name as
specified in the IDL file (there is no 8-character limitation) is sent from a Natural client to the
server. Special characters are not replaced. The IDL program alias is not sent to the server, but it
is used to derive the suggestion for the source file names of the client interface objects (NSN, PDA,
PGM) instead using the IDL program names. See Step 2: Customize Natural Client Names.

If you are using instead so-called stubs generated with SYSRPC (not recommended) or stubless
Natural RPC (also not recommended) the IDL program name as specified in the IDL must match
the name in your CALLNAT statement. In this case the IDL program is limited to 8 characters.
Example:

CALLNAT 'MYSRV' P1 P2 P3
Server Side

If you are using a server mapping file (see Server Mapping Files for Natural), the target RPC server
(Natural subprogram, extension .NSN) is located with the help of this file. This has the following
advantages:

® IDL program names do not have to match the target RPC server (Natural subprogram, extension
.NSN) names.
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® Target RPC server names (Natural subprogram, extension .NSN) can be customized during
wrapping (see Step 2: Customize Natural Server Names) or during extraction (see Step 6: Redesign
the Interface for Natural Subprograms (Optional)).

® IDL program names are not limited to 8 characters.

The server mapping file is generated either during wrapping (see Using the Natural Wrapper for
the Server Side) or during extraction (see IDL Extractor for Natural). It is wrapped into the RPC
client components and the relevant information is sent from a client to the server. Therefore it is
important to generate or extract the target Natural RPC (Natural subprogram, extension .NSN)
server first, before creating any RPC client component.

If you are not using a server mapping file, the target RPC server (Natural subprogram, extension
.NSN) must match the IDL program name. In this case the length of the IDL program name is
limited to 8 characters.

Mapping Parameter Names

The parameter names as given in the IDL file are replaced by artificial names in the generated
Natural interface object (stub subprogram). See parameter-data-definition under Software AG
IDL Grammar in the IDL Editor documentation.

Mapping Fixed and Unbounded Arrays

* Fixed arrays within the IDL file are mapped to fixed Natural arrays. The lower bound is set to
1 and the upper bound is set to the upper bound given in the IDL file.

See array-definition under Software AG IDL Grammar in the IDL Editor documentation for
the syntax on how to describe fixed arrays within the IDL file and refer to
fixed-bound-array-index.

® Unbounded arrays within the IDL file are mapped to Natural X-arrays. The lower bound is always
fixed and set to 1.

See array-definition under Software AG IDL Grammar in the IDL Editor documentation for
the syntax of unbounded arrays within the IDL file and refer to unbounded-array-index.
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Mapping Groups and Periodic Groups

Groups within the IDL file are mapped to Natural groups. See the group-parameter-definition
under Software AG IDL Grammar in the IDL Editor documentation for the syntax on how to describe
groups within the IDL file.

Mapping Structures

Structures within the IDL file are mapped to Natural groups. See structure-definition under
Software AG IDL Grammar in the IDL Editor documentation for the syntax on how to describe
structures within the IDL file.

Mapping the Direction Attributes In, Out, InOut

The IDL syntax allows you to define parameters as IN parameters, OUT parameters, or IN 0UT
parameters (which is the default if nothing is specified). This direction specification is reflected
by Natural as follows:

® Parameters with the OUT attribute are sent from the RPC client to the RPC server. They are always
provided with the call by reference method.

® Parameters with the IN attribute are sent from the RPC server to the RPC client. They are always
provided with the call by reference method.

® Parameters with the IN 0UT attribute are sent from the RPC client to the RPC server and then
back to the RPC client.

® Only the direction information of the top-level fields (level 1) is relevant. Group fields always
inherit the specification from their parent. A different specification is ignored.

Seethe attribute-1ist under Software AG IDL Grammar in the IDL Editor documentation for the
syntax on how to describe attributes within the IDL file and refer to direction attribute.

| Note: If you define an interface object layout in the Natural application SYSRPC, the
meaning of the direction attributes IN and 0UT are reversed compared to the IDL:

® INin SYSRPCis OUT in IDL
® 0UT in SYSRPC is IN in IDL
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Mapping the ALIGNED Attribute

The ALIGNED attribute is not relevant for the programming language Natural. However, a Natural
client can send the ALIGNED attribute to an RPC server where it might be needed. To do this you
need a Natural interface object (stub subprogram) that has been generated from an IDL file.

See the attribute-1ist under Software AG IDL Grammar in the IDL Editor documentation for the
syntax of attributes in the IDL file and refer to the aligned attribute.

Calling Servers as Procedures or Functions

The IDL syntax allows definitions of procedures only. It does not have the concept of a function.
A function is a procedure which, in addition to the parameters, returns a value. Procedures and
functions are transparent between clients and servers. This means a client using a function can
call a server implemented as a procedure, and vice versa.

Client and Server Side

The Natural RPC does not support functions.
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Writing RPC Clients for RPC-ACI Bridge in Natural

Prerequisites

The parameters of the IDL program must contain an A field with a length of at least 254 bytes or
of unlimited length. You need to have dynamic data types in your IDL. You must use COMPR=2
(send buffer completion).

Writing a Natural Client

> To write a Natural client

1  Use CALLNAT for the Natural RPC client.

2 Provide a context for EntireX as described under Interface RPC-CNTX for the Natural RPC
Client Programmer below. See the Natural documentation for details.

The RPC-ACI Bridge reports errors on the ACI side or the Broker for ACI with Natural error 998
(Internal error details). The details contain the error number followed by a description. Use Nat-

ural subroutine USR2030N to retrieve error class, error code and description. The error class for the
RPC-ACI Bridge is 1018. See Message Class 1018 - EntireX RPC-ACI Bridge.

For error handling, use for example (the declarations of the variables are omitted):

ON ERROR
IF *ERROR-NR = 998 THEN
CALLNAT "USR2030N' ERR-PARM(*) OCC RESPONSE
IF 0CC > O THEN
MOVE SUBSTRING(ERR-PARM(1), 1, 8) to #fERR-CODE
MOVE SUBSTRING(ERR-PARM(1), 10) to ffERR-DETAIL
WRITE #fERR-CODE
WRITE #fERR-DETAIL (AL=79)
ESCAPE ROUTINE
END-IF
END-IF
END-ERROR
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Interface RPC-CNTX for the Natural RPC Client Programmer

API RPC-CNTX s used for providing a context for RPC client applications. RPC-CNTX combines
the functionality of several APIs and is available in library SYSTEM. There is no need for extra
preparations such as setting a STEPLIB or copying APIs from SYSEXT to user libraries.

RPC-CNTX makes the following interfaces from SYSEXT obsolete: USR1071N, (USR4371N),
USR6304N, USR2007N, USR4008, USR4009, USR2071N.

For the usage of RPC-CNTX refer to the test programs generated by the Natural Wrapper, see
Sample Generation Result for the Client Side.

For further information refer to the Natural RPC documentation.

Returning Application Errors from an RPC Server to an RPC Client

Application error codes enable the RPC server to return customer-invented errors back to the RPC
client in a standardized way without defining an error code field in the IDL file.

USR4012N from Natural library SYSEXT may be used to enforce Natural error NAT1999 on the
Natural RPC server and to pass back the provided error text to the RPC client.

Example

/* Application Error

COMPRESS "ERROR: " #fERR-TEXT INTO #LOG-TEXT
/* Send back Application Error to Client
CALLNAT 'USR4012N' USING #fERR-TEXT

For more information:

® Logon to the Natural library SYSEXT within your Natural installation, enter command MENU
and select USR4012N.

" Refer to the http://documentation.softwareag.com > Natural Product Line.

® See the Basic RPC Server Examples - CALC, SQUARE.
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Interfaces (APIs) Available in SYSEXT

The Natural library SYSEXT provides APIs for RPC programming. Log on to the library SYSEXT
and enter MENU. To list only RPC-related APIs, enter the keyword RPC. To make these APIs available,
make the necessary STEPLIP settings or copy the APIs from SYSEXT to user libraries. For more
information, refer to the API documentation provided by SYSEXT.

Interface Comment

USR1071N |Set user ID and password for RPC

USR2007N |Set/get RPC default server information.

USR2015N |EBCDIC or ASCII translation table for Natural RPC.
USR2032N |Support of commit for CLOSE CONVERSATION.
USR2035N |Support of SSL.

USR2071N |Support of EntireX Security on client side.

USR2072N |Support of EntireX Security on server side.
USR2073N |Ping or terminate an RPC server.

USR2074N |Set new password for NSC user in RPC context.
USR2075N | Terminate EntireX Broker service.

USR4008N |Set library for RPC execution.

USR4009N |Set parameters for EntireX.

USR4010N |Retrieve runtime settings of server.

USR4012N |Support of application error.

USR4371N |Set user ID and ETID for RPC.

USR6304N |Set/get reliable state for RPC execution.
USR6305N |Commit/rollback reliable RPC message(s).
USR6306N |Status of UOWs of current EntireX Broker user.

etc.
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9 Client and Server Examples for Natural

= Basic RPC Client Examples - CALC, SQUARE
= Basic RPC Server Examples - CALC, SQUARE
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This chapter describes the examples provided for Natural. All examples here can be found in the
EntireX examples/RPC directory under UNIX and Windows.

Basic RPC Client Examples - CALC, SQUARE

Name Type Description Notes

CALCCLT.NSP |Natural Program |A client application calling the remote procedure (RPC service) |1, 2
CALC, with associated example.idl.

SQRECLT.NSP |Natural Program |A client application calling the remote procedure (RPC service) |1, 2
SQUARE, with associated example.idl.

] Notes:

1. Requires a Natural version supported by Software AG.

2. Application uses a client interface object built with the Natural Wrapper.

For more information see the readme file in EntireX directory examples/RPC/NaturalClient under
UNIX or Windows.

Basic RPC Server Examples - CALC, SQUARE

Name Type Description Notes
CALC.NSN  |Natural Subprogram A server application providing the remote procedure|1
(CALLNAT) CALC (RPC service), with associated example.idl.
SQUARE.NSN |Natural Subprogram A server application providing the remote procedure|1
(CALLNAT) SQUARE (RPC service), with associated example.idl.
| Notes:

1. Requires a Natural version supported by Software AG and a Natural RPC Server.

For more information, see the readme file in EntireX directory examples/RPC/NaturalServer under
UNIX or Windows.
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